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Introduction
A Brief Description
Terry the Turtle 2 is an ideal program for introducing children to turtle and logo 
type applications. Terry 2 includes lots of new features that allow teachers and 
children to explore Movement, Turtling and Logo. Terry’s clear and easy to use 
interface allows the children to move the turtle around on screen and create 
exciting patterns whilst learning about measurement of distance and angles. 

Terry 2 includes lots of new backgrounds and animated turtles, allowing children to 
navigate around mazes, outer space, the sea, UK maps and other environments.
The drawings in Terry can be exported for use in word processing or they can be 
saved out as QuickTime movies for use in web pages or simply to allow them to be 
played back, an ideal way of recording evidence of children’s work.

Terry supports many logo commands and sets of commands can be saved as 
procedures. The interface can be configured to meet the individual needs of the 
pupils.

Terry 2 is a fun way for children to explore turtle and logo work and can be used in 
different curriculum areas.

System Requirements
PC running Windows XP service pack 2 or Vista with at least 40MB of free disc 
space. 

A Macintosh running Mac OS 8.6 or higher, Mac OS X with a minimum of 40MB of 
hard disc space.

QuickTime 7 or above on all platforms.

Terry the Turtle 2 is copyright Kudlian Software Ltd. © 2002-2008. 

Licence
You must ensure that you have the correct number of licences to run the software 
on your computers. It is illegal to run software for which you have no licence. If 
the software was supplied pre-installed on a computer then it is only licensed for 
use on that machine. A separately purchased pack contains a licence, which may 
enable it to be used on a number of machines within a single establishment, for 
example a school.

All trademarks are acknowledged.
Terry the Turtle 2 © Kudlian Software Ltd. 2002-2008

Kudlian Software Ltd.
8A Nunhold Business Centre, Dark Lane,
Hatton, Warwickshire CV35 8XB
Email: support@kudlian.net   Web: www.kudlian.net
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Registering Your Software
Load the Terry 2 application in the normal way for your computer.
The first time that you run Terry you will be asked to enter your licence details. If 
you do not do this terry will run only in demonstration mode. When used in this 
state the application closes down after about five minutes and some features have 
been disabled.

To register the software:
Enter your details and the serial number in the appropriate places on the start up 
screen.

The serial number can be found with your licence details supplied with the 
software.

If you are trying to register a pre-installed demonstration version;

•	 Run Terry 2 and choose New from the panel.

•	 Click on the Help menu and choose About Terry 2...

•	 Click on the Register button and then enter your details in the Software 
Registration Panel.



Page 3

Running Terry the Turtle
Load the Terry 2 application in the normal way for your computer.
A panel will open. If you wish to start a new Terry screen then select the Blank 
radio button. If you wish to select one of the special backgrounds supplied with 
Terry 2, then select the With Background radio button and then click Start.

Once the Terry 2 Window has opened you can start using the application 
immediately. The first time that Terry 2 is run it will open at Level 1. It is possible 
to alter this configuration setting so that the program opens at one of the other 
three levels by default. You will need to edit the applications preferences and 
details on how to do this can be found on page 43.

Clicking on the buttons in the Command Bar on the left hand side of the window 
will cause Terry to move forward, back and turn left or right.

To change the colour of the line; click on the colour you require in the Colour Bar 
near the bottom of the screen. This will only affect the next line you draw.
At level 1, the currently selected colour is shown on the far right of the colour bar 
by the colour of the pen icon.

To change the background colour, click on the background icon located on the tool 
bar at the top of the screen. Choose a new colour from the colour picker. 

Finishing with Terry
To Close Terry
Close down the application in the normal way for your computer. If you have not 
saved your work, a message box will open asking if you wish to do so.
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Using Terry
When Terry starts the main window will open as shown:

By default this will be at Level 1. Further details on changing the level can be found 
in the Preferences section on page 43. 

The Terry screen is split up into four parts. 

The main area is known as the drawing area and this is where you will produce 
your designs and patterns with Terry.

Along the bottom of the drawing area are the colours that are available for use; 
this is known as the colour bar. The current pen colour is shown to the right of the 
colour bar.

Down the left hand side are the control buttons for moving Terry around the 
drawing area, this is known as the command bar. 

Across the top of the drawing area is the tool bar. If you allow the mouse to hover 
over the buttons you will see a tool tip informing you of the button’s function.

Click on these buttons to move the turtle 
forwards and backwards

Click on these buttons to turn the turtle left 
and right
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Tool Bar Buttons

 Starts a new file or opens a resource.

 Opens a browser window allowing you to load Terry trail files.

 Opens a browser window allowing you to save files.

 Prints the current Terry screen.

 Copies the current drawing to the clipboard. It can then be pasted into 
other applications such as word processors or DTP software.

 Opens a panel that allows you to choose different Line Styles.

 Opens a dialogue that allows you to choose different turtles.

 Toggles the sound on and off.

 Opens the colour picker allowing you to change the background colour of 
the drawing area.

 Starts recording a QuickTime movie.

 Stops recording a movie.

The turtle will appear in the centre of the drawing area.

To move the turtle either click on the appropriate button in the command bar or 
use the arrow keys on the keyboard.

Changing the Pen Colour

You can easily change the pen colour by moving the mouse pointer to the colour 
bar and clicking on a new colour. The pen icon to the right of the colour bar will 
change to reflect the colour you have just selected.

Now move the turtle again and it will draw a line using the newly selected colour.



Page 6

Start a New Drawing
If you want to start drawing on a clear Terry screen either: 

•	 Click with the mouse pointer on the CLEAR button on the left hand side of the 
Colour Bar, you will be prompted to save your work if you have not already done 
so. The screen will clear and the turtle will return to the Home position and you 
can begin drawing again.

Or;

•	 Click on the New button in the Tool Bar at the top of the screen.

	 Again you will be prompted to save work if necessary and then the opening 
Terry panel will appear.

•	 Click on the New button.

Changing the Turtle Type
Terry 2 has lots of new turtles included with the application and more will be made 
available through our web site at http://www.kudlian.net

You will find that some of the turtles are animated and may have sounds 
associated with them. In order to see and hear them you will need to ensure 
that the Turtle animation and sound options have been set in the applications 
preferences, see page 43.

•	 Click on the Turtle Button on the Tool bar.

	 A panel will open showing all of the currently available turtles. There is no 
difference to the drawings that are produced by any of the turtles. Sometimes 
it may be more appropriate to use a particular turtle shape depending on the 
activity.

•	 Move the mouse pointer to the turtle that you require and click the Select button 
on the mouse. The turtle will now be highlighted. To confirm your choice of 
Turtle click on the OK button or double click on the turtle. The new Turtle will 
replace the one previously on screen. At levels 1 and 2 the graphics on the 
buttons in the Command bar will also change to reflect the new turtle selection.

A number of special transparent turtles have also been included. These are ideal 
for drawing on maps or when you want to see exactly where the pen of the turtle is 
drawing.

Some turtles have sounds associated with them. If you cannot hear a sound from 
the turtle, you should first of all ensure that the sound button on the tool bar has 
been turned on and that sound is working on your computer.
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Screen Levels
Terry works at four different screen levels; these range from 1 to 4, allowing Terry 
to be used by very young children right through to Key Stage 2.

Level 1 is the easiest through to level 4, which is more complex. These allow Terry 
to be used by children working at different levels of attainment from Early Years 
through to Secondary School. The default level is 1 but this can be easily changed, 
please refer to page 43 for details on changing the default level permanently.

Changing the default level is a teacher set preference, it is however possible to 
quickly change levels using a keyboard short cut, this especially useful when 
demonstrating Terry.

Pressing the following keys on the keyboard will facilitate an immediate change of 
level;

CTRL+1 CTRL+2 CTRL+3 or CTRL+4 (on Windows)
Or

+1  +2  +3  or  +4  (on a Macintosh)

Starting at Level 1
Level 1 introduces the children to simple turtle movements; forwards, back, turn 
left and turn right. When the turtle is instructed to move forwards or back it will 
move one turtle unit. By default this is the turtle’s length but it can be altered in the 
Preferences panel, see page 43. When the turtle is instructed to turn left or right it 
will turn through 90 degrees.

When the turtle draws a line it draws it from its centre not from the tip of its tail or 
nose. This is the same way that floor turtles operate.
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Moving the Turtle

 Forward (FD) – Click on this button to move the turtle forwards one 
turtle unit.

 Back (BK) – Click on this button to move the turtle back one turtle 
unit.

 Turn left (LT) – Turns the turtle left through 90 degrees.

 Turn right (RT) – Turns the turtle right through 90 degrees.

Alternatively you can press the appropriate arrow keys on the 
keyboard.

You can also ‘pick-up’ the turtle and place it anywhere within the drawing area.

•	 Click the mouse button on the Turtle in the drawing area. You do not need to 
hold down the mouse button.

•	 As you move the mouse and you will see that the turtle follows the mouse 
pointer. 

•	 Position the turtle where you want it to start drawing and click the mouse button.

	 The turtle is now repositioned and ready to start drawing

If you inadvertently pick up the turtle and then want to return it to its original 
position, then press the Escape key on the keyboard.

Exercise - Draw a square with sides of 2 turtle units.

Start with the turtle at its Home position, in the middle of the screen.

•	 Click on the Clear button in the bottom left corner of the Terry window.

•	 Click twice on the Forward button.

•	 Click once on the Turn right 90 button (or Left 90).

•	 Click twice on the Forward button.

•	 Click once on the Turn right 90 button (or Left 90).

•	 Click twice on the Forward button.

•	 Click once on the Turn right 90 button (or Left 90).

•	 Click twice on the Forward button.

	 You should have drawn a square.
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Changing the Pen Colour
At the bottom of the drawing area is the Colour bar. At level 1 only sixteen 
different colours are displayed, levels 2 and 3 support 32 colours. 

You can change the colour of the line being drawn by clicking the mouse pointer 
over the colour you wish to use in the colour bar. The next line you draw will be 
using the new colour. The currently selected colour is shown by the colour of the 
Pen icon. On Level 2 the colour of the pen on the PU and PD buttons also shows 
the currently selected colour.

Level 4 supports all colours displayed by the computer. On level 4 the pen colour 
can only be selected by clicking on the pen icon and choosing from the colour 
picker or through logo commands by using the SETPC command followed by the 
appropriate Red, Green and Blue values. More details on this can be found on page 
40 Changing Pen Colour at Level 4.

Changing the Background Colour
To change the background colour:

•	 Click on the Background button on the Tool bar to open the colour picker

•	 Select a colour and confirm it.

	 The background colour will change immediately.

Changing the Line Style
•	 Click on the Line Style button in the tool bar to open the Line Style dialogue.

	 You can select different line widths and line patterns by pointing and clicking on 
the lines shown in this window.

•	 Click on the style of line you wish to use.

You can either close the window, or leave it open to choose other line styles.

Exercise – Drawing multi-coloured squares

•	 Clear the screen by clicking on the CLEAR button.

•	 Redraw the square but this time choose a new colour for each of the sides of the 
square.

•	 Change the background colour of your drawing.

•	 Move the Turtle to a new position by clicking and dragging it.

•	 Now draw a second square using a different line style.

•	 Clear the screen again.

Remember, you can also use the ARROW keys on the keyboard to move the turtle 
instead of using the buttons in the command bar.
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Backgrounds
Terry 2 has lots of backgrounds in its Library that can be loaded into the drawing 
area. As more backgrounds become available then they will be made available 
through our web site at http://www.kudlian.net

The background files are organized in different scenarios and in increasing levels 
of difficulty. Background files may have a task for the children to complete and the 
task may have more than one objective. By this we mean that the children have to 
manoeuvre the turtle from the Start to a finish point but they might need to pass 
through two or more points, or hot spots, in order for them to complete the task. 
When they reach the finish point a message or sound file will announce that they 
have completed the task. A default level has been set for each background along 
with an appropriate turtle, but these too can be configured.

In each background there is no pre-defined path that the turtle must take. If this 
were the case there would only be one solution for each screen. The pupils can 
move the turtle to any point on the screen. There may be a solution that you think 
is correct but it might not be the one the pupil has decided upon! We have found 
that a great deal of additional and beneficial work can be developed in discussions 
between the children and their peers and the children and the teacher, developing 
language and communication skills.

Loading a Background into Terry
We will use the set of Underground railway backgrounds for this example.

•	 Click on the New Document button on the tool bar.

•	 Click on the With Background radio button in the main Terry 2 panel and then 
click on the Start button.

•	 Open the pop-up menu in the panel and choose Underground from the list.

•	 Double click on the first background to load it.

	 A screen may appear informing you of what the objectives are. In this instance 
the objective is to travel from Queensway to Bond Street.

•	 Click on the OK button to proceed.

	 The Underground background will appear in the main drawing area.

	 The turtle will be at the start, Queensway.

•	 Use the arrow keys or the buttons to reach the objective.

	 When the objective has been reached you will receive a message on screen and 
if you have sound turned on, the sound effects will be heard.

If you wish to continue with this screen click on the Cancel button otherwise click 
on the Next button. This will take you onto the next background.



Page 11

Clearing the Screen
To return to a new drawing screen.

•	 Click on the New button on the tool bar and choose New from the main panel 
that appears.

	 You may be warned that your drawing will be lost if you do not save it. Please 
read all messages that appear on screen carefully in order to prevent accidental 
loss of work.
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Saving Your Work
Terry 2 is able to save your work in a number of different forms;

Terry ‘Trails’
Pictures / graphics
QuickTime movies
Web pages
As a graphic, copied to the clipboard

Terry 2 Trails – Terry saves your work as a Terry Trail file that 
contains all the information required to recreate exactly the state 
of the Terry application when you reopen the file. A trail file 
contains information about the turtle, background colours, paths 
and procedures plus any drawing that the turtle has created. Once 
the file has been loaded, you may then continue to work from 
where you left off.

To Save a Terry 2 Trail file;

•	 Click	on	the	Save	button	in	the	Tool	bar

•	 Type	a	name	for	your	file	in	the	Save	As	window

•	 Browse	to	the	folder	to	save	your	work	to

•	 Click	on	the	Save	button	in	the	Save	window.

The file will be saved in the directory that is displayed in the browser window.
If you wish you can change the directory folder using the standard browser buttons.

To load a trail file;

It is a good idea to start with a new screen.

•	 Click	on	the	New	button	on	the	Tool	bar.	You	may	be	prompted	to	save	work.

•	 On	the	Terry	panel	that	then	appears	click	on	the	Blank radio button and then 
on the Start button to create a new turtle page.

•	 Click	on	the	File	open	button,	to	open	a	browser	window.

•	 Browse	to	the	file	you	wish	to	load

•	 Highlight	the	file	and	click	on	the	open	button.

 The Turtle file will load and redraw the pattern on screen. Once the Turtle 
stops drawing, you can continue to work. You can load in a number of trail files 
one after the other but you cannot load two trail files that contain duplicate 
procedure names. That is to say, if you have used a procedure called Square in 
one Terry 2 file and used the same name in another procedure, then if you try to 
load them together you will get an error message. In order to load the two files 
they must have unique procedure names and you will need to edit one of them if 
this is not the case.
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Terry 2 Picture Files
You can also export any terry drawing as a picture file. This file can then be 
inserted into word processors and DTP documents. The drawing can also be 
exported either with or without the background. However if you want to place your 
drawing in a word processor or other application you may find it more convenient 
to use the Clipboard, see page 17 for more details.

To export a Terry picture file:

•	 Open the File menu and choose Export

	 The Export window will open.

	 A number of options for exporting your work can be chosen by clicking on the 
appropriate tabs in this window.

As a Picture;

	 You can choose to include the Turtle, Trail and Background in your picture by 
selecting the appropriate checkboxes. A preview displays the picture that will be 
saved.

•	 Click on the Export button.

•	 Enter a name for your picture in the Export Image As window.

•	 Choose the type of file you wish to export, by default this is a BMP picture file.

•	 Browse to the folder where you wish to save the file.

•	 Click on the Save button.

	 The file will be saved in the directory that is displayed in the browser window. 
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If you wish you can change the directory folder using the standard browser buttons.

As a Web Page;

	 Terry 2 allows you to export your work as a web page. The web page can 
contain the pupils name, the turtle trial, a snapshot of the trial and a QuickTime 
movie.

•	 Click on the Web Page tab

•	 Enter your name in the writable Name field.

•	 The School’s name should have been automatically written to this field but you 
may alter it here if you wish.

The following may be included in the web page;

	 Final Picture – The Terry picture that has been produced on screen.

	 A Full or Short Trail – A Full trail contains the logo commands in their full 
command form for example Forwards, Back, Left Right, Pen down. The Short 
option writes the tails out in shorthand format, FD for forward, BK for Back and 
so on.

	 Movie – Saves a QuickTime movie as part of the web page, you will need to 
have movies turned on in the Preferences panel and have recorded a movie. See 
page 16 for more details on recording QuickTime Movies.
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Once you have chosen which items you want to be saved in the web page, click on 
the Save button.
A browser window will open allowing you to select the destination for the web page 
to be saved to. It is a good idea to save it to a new folder and to name that folder 
appropriately.

The ‘web site’ will then be saved to the destination you have chosen. A web site 
can contain a web page index.html (always)
Terry Logo file – Logo.jpg (always)
QuickTime movie – 00002.mov (optional)
Terry picture – 0001.jpg (optional)

Once the web site has been saved you are given the option to either view the 
web page or continue. If you decide to view the web page, then click on the View 
button. Your Internet browser will be automatically loaded.
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Creating a QuickTime™ Movie
Terry 2 is able to save Turtle trails as QuickTime Movies, either as a separate 
movie file or embedded in a web page. QuickTime needs to be loaded onto your 
computer and you may have been prompted to ensure that it is installed on your 
computer during the installation process for Terry 2.

QuickTime is a fully cross-platform technology for Mac OS Classic, Mac OS X, 
Windows 95/98, Windows NT, Windows 2000 and Windows XP environments. 
Anything QuickTime can do on one platform it can do on the other. QuickTime 
can be used to play back digital movie images, sound files, web broadcasts and 
much more. If you require more detail on the QuickTime technology please visit 
the Apple Computer web site at http://www.apple.com

To create a QuickTime Movie in Terry 2;

It is a good idea to start with a new Terry page.

•	 Click on the Start Movie Recording button on the Terry 2 Tool bar.  

 A small camera symbol can be seen in the top right hand corner of the 
Terry window to show that recording is taking place.

	 Every move or change you now make to the turtle position, line and background 
colours and line styles are now being recorded. When you have finished drawing;

•	 Click on the Stop Movie Recording Button.

	 The movie-recording symbol will disappear and the Movie will be compiled. It 
may take a little while especially if the trail you have drawn is complicated.

Once the QuickTime movie has been compiled, the Movie Preview window will 
open. The movie can be replayed in this preview window by clicking on the Play 
button on the left hand side of the Preview window.

You can now either;
Record More – Click on this button to add more to your movie. The preview 
window will disappear and you will return to recording the movie. Carry on moving 
the turtle on screen and when you have finished click on the Stop Movie Recording 
button.

Export – Allows you to export the QuickTime movie as part of a web page.

Delete – Deletes the currently built movie, you cannot undo this action.

Save – Save the movie file as a QuickTime movie. You will be asked for a name to 
save it as and location for the file to be saved to.
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To Create a Web Page;

It is a good idea to start with a new Terry page.

•	 Click on the Start Movie Recording button on the Terry 2 Tool bar.

	 A small camera symbol can be seen in the top right hand corner of the Terry 
window, to show that recording is taking place.

	 Every move or change you now make to the turtle position, line and background 
colours and line styles are now being recorded. When you have finished drawing;

•	 Click on the Stop Movie Recording Button

	 The movie will now be compiled and will appear in the movie preview window.

•	 Click on the Export button

	 Fill in the appropriate details for Pupils name and school and save out the web 
page. Full details can be found on page 14.

Using the Clipboard (Copy and Paste)
Terry makes use of the clipboard for copying and pasting the drawing as a picture 
file. This is especially useful if you have created a drawing in Terry and then want 
to paste it into a word processor or DTP application.

To Copy to the Clipboard;
Use the turtle to draw a pattern on screen
Click on the Copy button in the Tool bar

Load up your word processor in the normal way for the application and when you 
have a new document on screen;

To paste the Terry picture. 
Usually you would open the Edit menu and then choose Paste. If you are unsure on 
how to do this please refer to the reference manual that came with the application.
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Printing
In order to print you must have setup a printer driver for your particular printer.

To print your drawing:

•	 Click on the Print button on the Tool bar at the top of the Terry screen

	 Or

•	 Open the File menu and choose the item Print...

	 The Print dialogue box will open similar to the one shown:

	 By default everything will be printed but it is possible to deselect items to be 
included in the print window.

•	 To print the drawing click on the OK button.

	 Terry will try to print your drawing as big as it can depending on your printer 
setup.
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Screen Levels
Terry has four different screen levels. Level 1 is the ‘easiest’ to use, through to level 
4, which is more complex. These allow Terry to be used by children working at 
different levels of attainment from early years through to secondary school.

For details on setting the default screen level please refer to the Preferences 
section on page 43.  Changing the default level is a teacher set preference, it 
is however possible to quickly change levels using a keyboard short cut, this 
especially useful when demonstrating Terry.

Keyboard short cuts can be used to quickly change from level to level. Pressing the 
following keys on the keyboard will facilitate an immediate change of level;

CTRL+1 CTRL+2 CTRL+3 or CTRL+4 (on Windows)
Or

+1  +2  +3  or  +4  (on a Macintosh)

Exploring Level 2
Pressing the keyboard short cut CTRL+2 on Windows or +2 on a Macintosh will 
take you to level 2.
 
Alternatively;

•	 Click on the Edit menu and then move to Level in the menu

•	 Choose the level you require in the menu that opens.

This is very similar to level 1 but introduces the children to a number of new 
features:

Pen up (PU) and Pen down (PD) buttons appear in the Command bar. Two new 
command buttons, HOME and CLEAR appear next to the Colour bar at the bottom 
of the screen. The number of colours available has also been increased to 32.

Pen up (PU) - allows the turtle to be moved without drawing a line. The pen mimic 
on the right hand side of the colour bar moves up to show. 
Pen down (PD) - when selected will start the turtle drawing again. The pen mimic 
on the right hand side of the colour bar moves down.

Note: At Level 2, the colour of the pen on the PU and PD buttons in the Command 
bar and the pen mimic on the right hand side of the Colour bar show the currently 
selected colour.
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HOME – When you click on this button it issues a logo command instructing the 
Turtle to return to the Home position or origin. By default this is the centre of the 
screen. The Home position may be different in some prepared background screens 
where the turtle may start from a designated position. The turtle will move to this 
position without drawing a line. The Home command cannot be undone.

CLEAR – The logo command CLEAR is issued. All drawing on the screen will 
be erased and the turtle will be returned to the origin. Although this is a logo 
command, as a safety measure in order to prevent work being accidentally deleted, 
you will be prompted to save any work before this happens. All commands in the 
trail window are also removed.

The Hide turtle and Show turtle commands are available as a keyboard short cut 
and as menu options.

CTRL+T on Windows or +T on a Macintosh will toggle the turtle on and off or 
you can open the Turtle menu at the top of the window and click on Hide or Show 
Turtle.

Exploring Level 3
Pressing the keyboard short cut CTRL+3 on Windows or +3 on a Macintosh will 
switch to level 3.

Alternatively;

•	 Click on the Edit menu and then highlight Level 

•	 Choose the level you require in the menu.

At level 3 the graphical command bar is replaced by one in which the commands 
are represented by buttons displaying logo type commands and is fully 
configurable allowing you to add and remove buttons from the command bar and 
create your own button sets.

Level three allows you to move the turtle through a greater variety of pre-defined 
distances and degrees of turn instead of just one unit forward or back and turning 
through 90 degrees left or right.
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The default set of buttons has the following commands;

Moves the turtle forward 1 turtle unit

Moves the turtle forward 2 turtle units

Moves the turtle forward 3 turtle units

Moves the turtle forward 4 turtle units

Moves the turtle forward 5 turtle units

Turns the turtle left through 30 degrees

Turns the turtle left through 60 degrees

Turns the turtle left through 90 degrees

Lifts the pen up

Clears the screen and returns the turtle 
to the starting, Home, position

Moves the turtle back 1 turtle unit

Moves the turtle back 5 turtle units

Moves the turtle back 4 turtle units

Moves the turtle back 3 turtle units

Moves the turtle back 2 turtle units

Turns the turtle right through 30 degrees

Turns the turtle right through 60 degrees

Turns the turtle right through 90 degrees

Lowers the pen down

Returns the turtle to the Home position, 
screen is not cleared

Changing the Button sets in the Command Bar
In Level 3 you can select alternative Command button sets and create additional 
button sets to use in Terry 2.

Choose Customise Command Bar from the Edit menu.

You can now choose a different button set, by clicking on the pop-up menu button, 
then selecting a new button set from the list.

Close the Customise Command window.

The following button sets have been included with Terry 2 and cannot be modified;
Default Logo Commands
Logo Commands (Reduced)
Compass Points
Compass Points (Reduced)

Two sets of buttons have been included to help children learn about points of the 
compass. You should be aware that turning the turtle using a compass bearing is 
slightly differently to the way in which a logo command is issued, for example;
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The Terry 2 screen is orientated so that North is to the top of the screen, South 
the bottom of the screen, West the left hand side and East the right hand side. 
Instructing the Turtle to go South (S), physically turns the turtle to point in the 
direction of the bottom of the Terry screen. If the turtle is facing North to begin 
with, it will be turned through 180 degrees, it will not just simply move back. If the 
turtle was facing West initially, it will be turned through 270 degrees in order to 
face south.

Although we have used buttons with points of the compass on to identify them, in 
actual fact they are still using the correct logo command SETHEADING to carry 
out the move. This can be clearly seen if you open the Trail window after issuing a 
command.

Turning to face South uses the logo command SETHEADING (SETH) 180. This 
means that regardless of the direction that the turtle is facing clicking on the South 
button will always issue the SETH 180 command, and the turtle will always point 
to the bottom of the screen.

Try this;

•	 Make sure you are currently working at Level 3, the screen is clear and the turtle 
is in the home position.

•	 Choose Customise Command Bar from the Edit menu.

•	 Click on the pop-up menu and choose Compass Points

	 The Command bar will now show the points of the compass, and forwards and 
back buttons.
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Creating your own Button Sets
•	 Make sure you are currently working at Level 3, the screen is clear and the turtle 

is in the home position.

• Choose Customise Command Bar... from the Edit menu.

•	 Click on the pop-up menu button and choose New Set... from the list.

•	 Type in a name you would like to use for the new set of buttons and then click 
on the OK button

	 A panel will now appear displaying tabs that have different types of command 
buttons.

	 To create your own set either;

•	 Drag the button across to the command bar on the left hand side of the screen

	 Or

•	 Double click on the button in the window.

	 You cannot save a button set that does not contain any buttons. If you try to 
close the Customise Command Bar window without adding any buttons to a new 
set the Command Bar will default back to the previously displayed set.

The number of buttons you can have in the command bar is determined by the 
value that has been set for the button size in the Preferences panel, see page 43 for 
details on setting preferences. If you are using a desktop resolution of 800 x 600 
then the number of buttons that can be displayed are;
Small buttons – 42 buttons
Medium Buttons –26 buttons
Large Buttons – 20 buttons

The buttons that you can add to the command bar are divided into sets;

Movement - Forwards and Back
Direction - Turning the turtle right and left
Compass - points of the compass, N, NE, E, SE, S, SW, W, NW
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States – conditions of the pen, up or down and Screen commands, Home and 
Clear.
Custom – allows you to add your own command buttons

Custom Buttons
Custom buttons allows you to build up a button set or add to an existing button 
set, commands that are not included in the other sets, for example RT 25, LT 78. 
In order to create a button set containing your own commands;

•	 Make sure you are currently working at Level 3, the screen is clear and the turtle 
is in the home position.

•	 Click on Edit in the Menu

•	 Choose Customise Command Bar…

•	 Click on the pop-up menu and choose New Set…

•	 Enter a name for your set of buttons to saved under

•	 Click on the Custom tab

•	 Type a title in for your button, this should be kept as short as possible, and you 
can have no more than six characters. (In some screen resolutions and button 
sizes, not all of the characters might be displayed).

	 E.g. to turn right 130 degrees, use RT 130

•	 Type in the logo command for this button, for this example type RT 130

•	 Click on the Add button

	 The button will now appear on the left hand side of the screen in the Command 
Bar. You can add more buttons in the same way or choose from any of the other 
panels.

	 Buttons can also contain a short procedure for example; FD 2 RT 90 FD 2

Once you have all the buttons you require click on the Save button.
The Save button will only be active when buttons have been added to a button set. 
You cannot have a button set that does not contain any buttons.

Deleting Buttons
To delete a button from the Command bar you must be in Edit mode.

	 Make sure you are currently working at Level 3, the screen is clear and the turtle 
is the home position.

•	 Click on Edit in the Menu

•	 Choose Customise Command Bar…

•	 Click on the pop-up menu and choose Edit Set...

•	 Select the Button Set you wish to edit.

The buttons in the Command bar will become selected and the customize panel 
will open. To delete a button drag it out of the Command bar onto the Terry screen 
and release the mouse button, the button has now been removed from the current 
set. You will now need to save the button set in order for the change to be made 
permanent.
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Deleting a Button Set
•	 Make sure you are currently working at Level 3, the screen is clear and the turtle 

is in the home position.

•	 Click on Edit in the Menu

•	 Choose Customise Command Bar…

•	 Click on the pop-up menu and choose Edit Set

•	 Select the Button Set you wish to edit

•	 Click on the Delete button to delete the button set or Rename to rename it

•	 Click on the OK button

If you choose to delete a button set then this action cannot be undone.
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The Menu Bar
Before we explore level 4, there are a number of features that Terry 2 has that can 
be used very effectively at the first three levels, as well as Level 4. These features 
are not necessarily accessible from either the command or tool bars or through 
keyboard short cuts. They can only be accessed through the menus at the top of 
the screen. 

The features are extremely useful as amongst other things, they allow you to 
follow what the children have been doing on screen and ensure that you can obtain 
evidence of the pupils work.

Palette Windows
A number of palettes can be opened. They display information and can be 
positioned anywhere on the screen by clicking on them a dragging them to a new 
location. When you then close and reopen a palette window it will open in the last 
position.

The Trail Palette
Each time a command is sent to the turtle it is recorded in the Trail. 

•	 Choose Show Trail from the Window menu.

The trail window shows all of the logo commands entered by the pupil through 
keyboard or command button presses. It can be left open on screen whilst the 
turtle is moved around. The last command executed is always highlighted.

	 A powerful addition to Terry 2 is that a trail can now be saved as a procedure. 
When the Trail window is open on screen;

•	 Click on the Store button

•	 Type in a name for the procedure

•	 Click on OK.

	 The procedure has now been saved under the name you have typed; we can 
check this in a moment. The procedure name cannot contain any numerical 
values and you will not be allowed to store two procedures with the same name.
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You could clear the trail window of all commands or continue to move the turtle 
around on screen. You should be aware that if you continue and then store a trail 
again, the new trail contains ALL of the information in the trail window.

Right clicking with the mouse in the trail window (Ctrl click on Macintosh) opens 
a menu that allows you to toggle between a fully expanded set of logo commands 
and the shortened versions. 

The Trail can be exported as a text file.

•	 Click on the File option in the menu at the top of the Terry screen and select 
Export from the menu.

•	 Click on the Trail Text tab

The panel has three options that can be checked;
Full List, Compact and Indented

A mimic displays how the text is going to look. An example is given below with the 
same procedure being displayed in each of the three views.

Full List – Displays each logo command undertaken by the turtle, no procedure 
names or repeats are shown

FD 1
RT 90
FD 1
RT 90
FD 1

Compact – Displays the Procedure Names followed by any logo commands that are 
not part of the procedure.

SETPOS[ 100 50 ]
SQUARE
LT 90
PU 
FD 3
RT 90
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Indented – Displays the procedure name followed by the logo commands contained 
within the procedure, followed by the second procedure.

SQUARE
	 FD 1
	 RT 90
	 FD 1
	 RT 90
	 FD 1
	 RT 90
	 FD 1
	 RT 90
PU 
FD 3
RT 90
PD 
SETPC [255 0 255]
OCTAGON
	 REPEAT 8
	 FD 1
	 RT 45

To close the trail window either click on the close button at the top of the window 
or choose Hide Trail from the Window menu.

The Position Palette
When open this gives visual feedback as to the exact co-ordinates and direction 
of the turtle on screen. This window is useful at Level 4 when you might be writing 
routines that require turtle accuracy.

To close the position window either click on the close button at the top of the 
window or choose Hide Position from the Window menu.
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The Line Style Palette
This palette allows you to quickly see the currently selected line style and change 
it if you so wish.

•	 Choose Show Line Style from the Window menu

When you move the turtle on screen it will draw the line that you have chosen. The 
line style palette can remain open on screen, allowing you to change the type of 
line being drawn at any time.

If you wish to close the Line style window then click on the close button at the top 
of its window.

The Variables Palette
This displays the variables currently known by the application during the current 
session.
•	 Choose Show Variables from the Window menu.

The palette will list the names for the variables and their values.

To Add a Variable
•	 Clicking the + button in the variable palette opens the Modify Variable dialogue 

box.

•	 Type in the name of the new variable in the name field and its numerical value in 
the value field.



Page 30

•	 Click on the Add button

	 The variable will now appear in the variables palette.

The Make Command
You can use the MAKE command in the command line, the syntax for this is:

MAKE <variable name> <value>

E.g.
MAKE Side 2

When you press the Enter key the variable Side would be added to the list of 
variables.

If you use the MAKE command in a procedure then the variable is only added to 
the list once when the procedure is first run.

The Name Command
The NAME command can also be used to create variables but the syntax is slightly 
different to the MAKE command. The syntax for NAME is:

NAME <value> <variable name>

E.g.
NAME 90 RightAngle

The variable RightAngle can now be used in repeats and procedures.

To Edit a Variable
•	 Open the Variables Palette

•	 Double click on the variable you wish to edit.

	 In the Modify Variable dialogue box you can edit the value of the variable but not 
change its name.

Variables may also contain numeric operands. For example:

MAKE Side 1+5

Deleting a Variable
•	 Click on the name of the variable you wish to delete in the Variables Palette and 

click on the – button.

Any variables defined during a session are saved with the Terry trail file. Variables 
not saved in this way will be lost when you start a new Terry file.
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Using Variables at Level 4
We will create a procedure using the following variables to produce a polygon.
•	 Set Terry to Level 4 using the Edit menu.

•	 Open the Variables Palette.

•	 Either in the command line enter the following commands

	 MAKE SideLength 3

	 MAKE NumberOfSides 5

Or

•	 Set the two variables to the values shown above in the Variable Palette.

	 The Variables Palette should look like this.

Now let’s create a repeat using the variables to draw a polygon.

•	 From the Procedures menu choose the item New Repeat...

•	 Enter the following text into the repeat dialogue box as shown:

•	 Click on the Store button and store the repeat as a procedure called Polygon

•	 Close the Repeat dialogue box

•	 Enter the command Polygon into the command line and press GO.

	 The turtle should now draw a pentagon.

•	 Try changing the value of the variable NumberOfSides to 3, 4, 6 or 8 and press 
the GO button each time. You should see a range of polygons being drawn with 
the number of sides equal to that which is set in the variable.
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The Procedures Palette
This displays the procedures currently known by the application during the current 
session. 

•	 Choose Show Procedures from the Window menu.

If you saved a Trail or a Repeat as a procedure the name will appear in this 
window.

To run a procedure from the Procedure window;

•	 Click on the name of the procedure you wish to run

•	 Click on the Go button

	 The procedure will now begin to run in the drawing window. You can alter the 
speed that the turtle is drawing at, by dragging the slider bar left to slow down 
and right to speed up.

To stop a procedure running click on the Stop button or use the keyboard short cut 
CTRL+. (Full-stop) on Windows or +. on a Macintosh.

•	 Once your procedure has been run open the Trail window again. 

Only the name of the procedure is shown in the Trial window but this can be 
expanded to show all of the commands within the procedure, by clicking on the 
expansion button next to the procedure name.

The Objectives Palette
When a pre-prepared background is loaded into to Terry it 
might have objectives associated with it for example, a map of 
the underground might ask you to move the train from Victoria 
to Vauxhall and in order to do so the train must also go through 
Pimlico. Each of the stations has been set as a goal. When 
choose Show Objectives has been selected, the objectives 
for the particular background are listed in order. As the turtle 
passes over them the text in the window will change colour. 
This shows that the Turtle has successfully reached one of the objectives.
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Screen Level 4
Screen level 4 introduces the children to the logo language and allows you to 
progressively introduce them to its many features. The layout of the main window 
is also different. There is now a command line situated at the bottom of the 
drawing area.  Each time you click on a command button in the command bar the 
command is inserted into the command line. When the command is correct it will 
appear in blue. This colour may be changed in the preferences, see page 43. You 
may also type commands directly into the command line.

The buttons in the command bar respond in a slightly different way offering a 
degree of visual feedback to the user. At certain times some of the buttons will 
grey out. When they are in this state they cannot be used in the command line. 
The only active buttons are those that are still solid. This means that the children 
cannot enter a command using incorrect syntax such as FD BK 5. The buttons 
in the command bar allow the children to enter commands that are not limited to 
prefixed units for example RT 56 would make the turtle turn through 56 degrees, 
or BK 5, back 5 units.

On level 4 the commands will not be carried out until you click on GO.

PD and PU are the Pen Down and Pen Up commands respectively.

Repeat... – Opens the repeat window. You can then create a repeat and store it as a 
procedure, more details on this can be found on page 34. Procedures created in 
this way may then be used in the command line by typing in their names.

To... – Opens the procedure window. Children can create procedures that might 
contain other procedures. To use a procedure within another procedure just type in 
its name.

Clear – carries out the logo command to clear the screen and return the turtle to 
the home position.

GO – carries out the procedure written in the command line.

Stop – Stops the procedure being executed.

Wipe – clears the command line of all instructions and commands.

The procedures that are built up in the command line may also be kept, and then 
used as part of other procedures. You will need to run your command line to begin 
with and then save using the trail window in the normal way.
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Try this;

Make sure you are working on level 4.

•	 Open the Trail palette

Build this procedure to draw a square:

•	 Click on Repeat...

	 The Create Repeat window will appear. You will need to type in the commands 
from the keyboard.

•	 Type 4, for the number of repeats

•	 In the brackets type[ FD 2 RT 90 ], these can be on separate lines or the same 
line.

•	 Press the Enter key, the Go button will now be active 

•	 Click on GO

	 A square will be drawn on screen

To save this procedure;

•	 Click on Store, in the Create Repeat window

•	 Type in a name for this procedure to be saved under, e.g. SQUARE

	 The procedure will now have been added to the list of procedures and may be 
used in other procedures during the session.

Note - You cannot save two procedures with the same name. You will be prompted 
to choose an alternative name if you try to do this.

If you now open the Procedures window you will see the name of the procedure 
you have just saved.

To Keep the Command Line
If you intend to use the command line to type in a short set of commands it is a 
good idea to ensure that the Trail window is clear before running your Command 
line program.

To do this;

•	 Open the Trail palette.

•	 Click on GO to run your command line.

	 The procedure will appear in the Trail window and the turtle will draw the trail.

•	 Click on the Store button at the bottom of the Trail window.

•	 Type in a name to store the trail as.

•	 Click on the OK button.
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To View the Procedures
The procedures in the library can themselves be used as parts of other procedures, 
this known as ‘nesting’. Their names can be typed into the command line. In order 
to view the procedures that Terry knows about;

•	 Click on the Window option in the menu at the top of the Terry screen and 
choose Show Procedures.

Try this;

•	 Using the REPEAT... command at level 4, create a square with sides of 2 units. 

•	 Store this with the name SQUARE

•	 Using the REPEAT... command create a procedure Repeat 4 [Square RT 30]

•	 Store this with the name PATTERN

•	 Using the REPEAT... command create a procedure REPEAT 3 [PATTERN]

•	 Store this with the name COMPOSITE

If you have anything drawn on screen;

•	 Click on the CLEAR button in the Command bar

•	 Click on the GO button in the Command bar

•	 Click on the Wipe button next to the Command line

	 This ensures that you have a clear screen

•	 Open the Trail window, Clear it if it contains any commands.

•	 Type COMPOSITE in the command line.

•	 Click on the Go button.

	 The Turtle will now draw a pattern on screen as shown on the next page.
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The Trail window will show the word COMPOSITE. If you expand this command 
by clicking on the small disclosure symbol next to the word COMPOSITE you will 
see that COMPOSITE is in fact made up of four procedures named TO PATTERN. 
Expanding the procedure PATTERN shows that it contains the Procedure SQUARE 
and a RT 30 command, and if you expand the SQUARE procedure you can see its 
structure as well.

Note – Composite has been supplied as an example file on your media or can be 
downloaded from our web site at http://www.kudlian.net
Follow the links for Terry.
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Building Procedures
Terry supports the logo command TO in order to create procedures. A procedure is 
set of logo commands which can be run one after the other. Procedures may also 
contain other procedures ‘nested’ within them. Each procedure must be given a 
unique name. You will be asked for this when you start to create a procedure.

•	 Ensure you are using Level 4

•	 Click on the TO... button

	 The Procedure window will appear. You must start by typing in a unique name 
for the procedure.

•	 Type logo commands into the procedure window. If you have used the correct 
command and syntax the text will change colour, by default this will be blue but 
this colour may be changed in the preferences panel, see page 43.

A line in a procedure may contain more than 1 command for example;
FD 5 RT 72

It may also contain the names of other procedures that you have used during a 
session.

Try this;
We are going to write a number of procedures to create a file called STARBURST. 
You will need to ensure that you are working at level 4 and that you are starting a 
new file. This file has also been supplied as a demonstration file.

•	 Create a procedure called Triangle

•	 Click on the Repeat... button

•	 Type the number 3 (this the number of times the commands will be repeated)

•	 Press the Enter key
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Type

	 FD 3

	 RT 120

•	 Store this Repeat as TRIANGLE

•	 Click on the To... button

Type

	 STAR (this is the name for the procedure)

•	 Press the Enter key

Type

	 TRIANGLE

	 PU

	 FD 2

	 RT 60

	 BK 1

	 PD

	 TRIANGLE

•	 Save this procedure by clicking on the Store button.

We now have the basic components to build our STARBURST picture.

•	 Click on the To... button

•	 Type STARFIELD as the name of the procedure.

•	 Press the Enter key.

Type the following commands, each on a separate line.

	 SETBG [0 0 0]

	 SETPOS [-313 113]

	 SETPENCOLOR [255 0 0]

	 PENDOWN

	 STAR

	 SETPOS [-318 -141]

	 SETPENCOLOR [255 255 0]

	 STAR

	 SETPOS [-132 83]

	 SETPENCOLOR [255 0 127]

	 STAR

	 SETPOS [121 211]

	 SETPENCOLOR [255 255 0]

	 STAR
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	 SETPOS [147 -121]

	 SETPENCOLOR [255 204 102]

	 STAR

	 SETPOS [284 -3]

	 SETPENCOLOR [0 0 255]

	 STAR

•	 Save the procedure by clicking on the Store button.

	 You should now save this file as a Trail file.

•	 Click on the Save button in the Terry 2 Tool bar

•	 Type in a name for it to be saved under.

	 You can choose the location for it to be saved to in this window in the normal 
way for your computer.

•	 Click on the OK button.

Opening a Trail File
•	 Click on the File open button in the Terry tool bar

•	 Browse to the location of the file in the normal way for your computer.

•	 Click on the file you wish to load

•	 Click on the OK button.

	 The Terry Trail file will now be loaded.

Editing Procedures
You can only edit a proceedure when it is not being used in a trail. You must first 
clear the trail window.

•	 Click on the Procedures menu at the top of the Terry window.

•	 Choose Edit Procedures...

•	 Choose the procedure you wish to edit from the drop down menu.

You can now choose to either;

	 Delete the Procedure, click on the Delete button.

	 Rename the Procedure, click on the Rename button and type in the new name at 
the prompt.

	 Edit the procedure, click on the Edit button, to open the Procedure editing 
window.

To edit the commands within a procedure;

•	 Position the caret at the point you wish to edit.

•	 Delete the characters or commands.

•	 Type in the new command.

•	 Press the Enter key.
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Note the Save button will only become activated after you have pressed the Enter 
key in order to confirm any changes that you have made.

If the command is correct the line will change colour confirming that you have type 
the logo command in correctly, by default this is from black type to blue type.

If you wish to delete a line, highlight the text in the line and press the delete key, 
then press the Enter key in order to confirm the deletion. The empty line will still 
be present but will be removed when the procedure is saved.

Changing Pen Colour at Level 4
There is no provision of a colour bar at level 4. The SETPENCOLOUR (SETPC) 
command can be used in procedures but if you wish to use a colour picker instead;

•	 Click on the Pen icon in the bottom right hand corner of the Terry screen.

	 This icon mimics the state of the pen, PENUP and PENDOWN, as well as 
showing the currently selected pen colour. Clicking on the icon opens the 
standard colour picker for your computer.

•	 Click on the colour you wish to use.

•	 Close the colour picker window.

	 The colour of the pen icon will now have changed and the Turtle will draw using 
this colour.

If you wish to know the RGB values for the pen colour you have just selected, open 
the Trail window. The new colour will be listed as a bank of three numbers, these 
are the red, green and blue values used in the colour, e.g. SETPC [255 0 0] is the 
logo command for setting the pen colour to RED. A table containing pen colour 
values can be found on page 47.
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Language Reference
Terry has a useful language reference library. This lists the commands currently 
understood by Terry and the syntax that should be used with each Logo command.

•	 Click on the Help item in the menu at the top of the screen and choose 
Language Reference from the menu.

The list of commands is updated during a session so will contain names of 
Procedures that you save in addition to the Logo command set.

Commands from the Language Reference palette can be dragged and dropped into 
the Command Line in Level 4, the Procedures dialogue and the Repeat dialogue.

Loading a Resource Screen
Resource screens are special background files that are distributed with Terry. 
There are many different resource files and they have been divided into ‘scenarios’. 
Within each scenario are a number of tasks. Each task is at different level and each 
has a target assigned to them. As additional scenarios and tasks are produced they 
will be made available through our web site.
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Keyboard shortcuts
Pressing the following keys on the keyboard will facilitate an immediate change of 
level;

CTRL+1 CTRL+2 CTRL+3 or CTRL+4 (on Windows)
Or

+1  +2  +3  or  +4  (on a Macintosh)

Some of the buttons in Terry have an equivalent keyboard short cut.
Forward (FD) - UP Arrow
Back (BK) - DOWN Arrow
Left (LT) - LEFT Arrow 
Right (RT) - RIGHT Arrow

By default the amount of turn is set to 90 degrees but this value can be altered in 
the application preferences, see page 43.

Hide / Show Turtle – CTRL+T or +T (Toggle)
Stop all Actions – CTRL+. or +. (Period)

CLEAR and CLEAN
These two commands are used in Logo to remove logo commands and graphics, 
but each command is slightly different.

CLEAR – Clears the screen of all graphics drawn by the turtle and also clears the 
trail window of any recorded commands. The turtle is also returned to its ‘home’ or 
starting position.

CLEAN – Clears the screen of all graphics drawn by the turtle but does not clear 
the commands in the trail window and the turtle remains in its current position.
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More Advanced Features
Changing the Preferences / Options
To change any of the default settings you need to open the Preferences / Options 
dialogue box.

To do this;

•	 Open the appropriate menu where the Preferences / Options item is located.

	 On Windows this is in the Edit menu

	 On Mac OS Classic this is in the File menu

	 On Mac OS X this is in the Application menu.

•	 Choose the Preferences... or Options... menu item.

This opens the Preferences / Options dialogue box:

The Preferences dialogue box allows you to change a number of settings;

The preferences panel has a Default button allowing the original settings to be 
returned.

General
School Name
This name will automatically be inserted when you register the software but can be 
edited at any time when exporting a web page. The name will appear in the web 
page when it is exported.

User Button Size
Sets the size of buttons used at Level 3, Small, Medium or Large. The number of 
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buttons you are allowed in the Control bar depends on a number of factors such 
as the size of button and screen size. You will be informed if there are too many 
buttons in the Command bar.

Default Level
Sets the level at which the Terry the Turtle program starts, 1, 2, 3 or 4.

Movement Unit
This is the distance that the turtle moves in a single unit for example the command 
FD 1 moves the Turtle forward 1 unit, by default this is set to 40 screen pixels 
which is the length of a turtle. Turtles always draw from the centre of the icon, as is 
the case with most floor robots and turtles.

Keyboard Turn
Sets the number of degrees that the turtle will turn when it is being driven by the 
keyboard arrow keys. By default this is set to 90 degrees.

Reach Boundary
When the turtle reaches the edge of the drawing area a response can be set to 
inform the user. This can be either;
A text prompt each time the boundary is reached
Text once and a sound associated with it
Just a sound.

Compact Trail
When a child presses the button to turn right 90 degrees this is recorded in the 
trail window. To turn right 180 degrees they therefore would need to press the 
button twice. The trial window will show two commands for RT 90. When compact 
trail is checked, it will display only one command RT 180.

Correct Colour
By default this is set to blue. 
When a Terry command is entered; if you have typed the command correctly the 
text will change from black to blue. This is also the case when naming procedures. 
If you try to duplicate a name the type will remain in black until you change it.

Show Splash Screen
By default the splash screen will appear when the Terry application is run. With 
older children you may not want this or you just want the application to start up 
more quickly. Unchecking this box stops the splash screen from appearing.
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Responses
This panel allows you to alter the audio features and speed of drawing to suite your 
computer.

Sound
These settings are not affected by the state of the Sound button in the Tool bar 
that is to say that you will still be able to hear the commands spoken even if you 
have turned sound off in the tool bar. You should ensure that your computer is 
able to play sounds and is equipped with the necessary peripheral devices such As 
speakers or headphones to allow sounds to be heard.

Sound Effects
When checked you will be able hear the turtle sound effects, by default this is off.

Vocal Feedback (Macintosh only)
When checked you will be able to hear vocal feedback from your computer for the 
logo commands, pen colour, etc. You should refer to the documentation that comes 
with your computer in order to ensure that vocal feedback can be heard.

Drawing
This slider control allows you to set the speed at which the turtle will draw on 
screen. You may find that in order to clearly see the turtle animations, the speed 
needs to be set to a slow setting. 

Turtle Animation
Checking this box turns the animation on turtles that have this feature. Not all of 
the turtles in Terry have animation and sometimes you have to look very hard to 
see it!
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Movies
Allow Movie Recording
When this option is checked it allows children to activate movie recording in Terry 
by clicking on the Movie recording buttons on the Tool bar. If this is not checked 
the Movie recording buttons will not appear in the Terry Tool bar.

Record Background Picture
This will include any background pictures in the recorded movie.
Record Turtle – includes the Turtle in the background movie.

Note, both of these settings are global and as such will apply to all movies that are 
recorded in Terry.

Output Size
Movies may be recorded in three different sizes;
Large – Full Screen
Medium – Approximately two thirds full screen size
Small – Approximately half full screen size

Terry 2 is under continual development. Upgrades and information regarding 
additional resources can be found on our web site. We are always pleased to 
receive input from users of Terry regarding possible improvements to the product 
as well as additional resources which we can make available to others through our 
web site.
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Appendix
Terry files
Terry files save all of the following information:
All procedures created during the session;
The background picture, if one is present;
The current screen level;
The x and y offset of the turtle relative to the centre of the drawing window, this 
position can be considered as the origin;
The direction of the turtle;
The scale of the turtle;
The type of turtle;
Any drawing done by the turtle.

When a Terry file is loaded it will restore the application to the same state as when 
you saved it.

Colours 
Terry is able to draw lines of any colour. At levels 1, 2, and 3 colours can be 
selected from the colour bar at the bottom of the screen. If you are using level 4 
the pen colour can be selected by clicking on the pen icon on the bottom right 
hand side of the Terry screen, or if you want to use a specific colour in a procedure 
you can use the values listed below. The values can be used for either the pen 
colour, using the SETPC command or the background colour by using the SETBG 
command. In each case you would follow the command with its RGB vale, e.g.;
SETPC [255 255 255] would set the pen colour to white
SETBG [255 0 0] would set the background colour to RED

Listed below are the RGB values for the colours used at level 3 in the colour bar. If 
you need to know the RGB value of any other colour you will need to use the trail 
palette and the colour picker to obtain these details.

Burgundy = SETPC [153 0 0]
Dark Red = SETPC [204 51 51]
Red = SETPC [255 51 51]
Dark Pink = SETPC [255 102 102]
Pink = SETPC [255 153 153]
Dark Green = SETPC [0 102 0]
Blue Green = SETPC [51 153 102]
Green = SETPC [0 204 0]
Light Green = SETPC [51 255 51]
Pale Green = SETPC [153 255 153]
Dark Brown = SETPC [153 102 0]
Brown = SETPC [204 102 51]
Orange = SETPC [255 127 0]
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Light Brown = SETPC [255 153 51]
Black = SETPC [0 0 0]
Dark Grey = SETPC [102 102 102]
Dark Purple = SETPC [153 0 153]
Purple = SETPC [204 0 204]
Light Purple = SETPC [204 153 255]
Magenta = SETPC [255 0 255]
Pale Magenta = SETPC [255 153 255]
Dark Blue = SETPC [0 0 153]
Blue = SETPC [0 0 255]
Light Blue = SETPC [51 153 255]
Turquoise = SETPC [0 255 255]
Pale Blue = SETPC [153 255 255]
Dark Yellow = SETPC [153 153 0]
Ochre = SETPC [204 204 102]
Yellow = SETPC [255 255 0]
Cream = SETPC [255 255 153]
Grey = SETPC [204 204 204]
White = SETPC [255 255 255]
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